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Module 1 — Performing Different Backup Types

Requirements

A Computer installed with Windows Server 2003 in the finalvision.com domain named DC1.

Exercise 1. Create Sample Data
1. Open Notepad and create a text file with the following

md c:\Data

net share data=c:\Data

md c:\Data\Finance

cd c:\data\Finance

echo Historical Financial Data > Historical.txt
echo Current Budget > Budget.txt

echo Employes > Employees.txt

echo Business Plans > BusinessPlan.txt

Save the file as “c:\createfiles.bat” excluding quotation marks

Open the command prompt

Type: cd c:\

Type: createfiles.bat

Open Windows Explorer and navigate to c:\data\finance — Ensure the files have been created

Check to if Attribute column is showing, if not then right-click column headers Date Modified and select
Attributes
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Exercise 2: Perform a Normal Backup

1. Open the Backup Utility by running Ntbackup.exe from the run line or from the Accessories-System Tools
menu
Clear Always Start In Wizard Mode check box
Click Advanced Mode
Click Backup tab
Expand My Computer the C Drive and the Data folder
On the Job menu choose Save Selections
Save the selections as Finance Backup.bks
In the Backup Media or Filename box type: c:\backup-normal.bkf
Click Start Backup and then click Advanced
. Confirm that Normal is selected in the Backup Type drop down-box then click OK
Select Replace The Data On the Media With This Backup and click Start Backup
. Watch the backup
. Examine the Report
. Close the report and the Backup Utility
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Exercise 3: Perform a Normal Backup

1. Open the Budget.txt file and add some text , Save and close the file

2. Examine c:\Data\Finance.. Which files are showing the archive attribute?
e Only one that was changed

3. Open Backup Utility and click the Backup tab

4. From Job menu, choose Load Selections to load Finance Backup selections

5. In the Backup Media or Filename box type: c:\backup-diff-day1.bkf

6. Click Start backup

7

8

9

Click Advanced and select Differential as the backup type
Start the backup and , when complete confirm no errors
. Close the Backup Utility
10. Examine the Budget.txt file it is still showing archiving
11. Make changes to the Employees.txt and confirm the archive bit is flagged
12. Repeat steps 3 to 9 creating a backup job c:\backup-diff-day2.bkf
13. Run the backup
14. How many files were backed up? 2

Exercise 3: Perform a Normal Backup

Open Backup Utility and click the Backup tab

From Job menu, choose Load Selections to load Finance Backup selections
In the Backup Media or Filename box type: c:\backup-inc-day2.bkf

Click Start backup

Click Advanced and select Incremental as the backup type

Start the backup and , when complete confirm no errors

Close the Backup Utility

Examine the archive bits, which are still showing archive? None

Make changes to the BusinessPlan.txt and confirm the archive bit is flagged
10 Repeat steps 1 to 8 creating a backup job c:\backup-diff-day3.bkf

11. Run the backup

12. How many files were backed up? 1
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Module 2 — Advanced Backup and Restore

Requirements

A Computer installed with Windows Server 2003 in the finalvision.com domain named DC1.

Exercise 1: Schedule a Backup Job

Open the Backup Utility and click the Backup tab
From the Job Menu, load the Financial Backup selections
Configure the Backup Media For File Name c:\backup-everyday.bkf
Click Start Backup
Click Advanced and configure an Incremental backup type. Click OK
Click Schedule
In the Set Account Information dialog box, type your password and click OK
Name the job Daily Incremental Backup
Click Properties
. Configure the job to run daily
. Configure the time to be two minutes from the current time
. Complete the configuration of the schedule job , enter your password again
Close the Backup Utility
. Open C Drive and wait two minutes
. Open Backup Utility , view the Report for the backup
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Exercise 2: Run a Backup from a Command Prompt

Open the Backup Utility and click the Schedule tab

Click the icon the calendar representing the scheduled job

Click Properties

Select the command in the Run box press Ctrl+C to copy it

Cancel and exit

Open a command prompt

Click the window menu and from the edit menu choose Paste and Press ENTER

Noukwnek

Exercise 3: Enable Shadow Copies

Ensure that the C:\Data folder is shared
Open My Computer

Right-Click the C Drive and choose Properties
Select the Shadow Copies tab

Select the C volume and click Enable

Confirm the message Click Yes
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Exercise 4: Simulate Changes to Network Files

Ensure that the C:\Data folder and add some text to Historical.txt
Delete the file c:\Data\Finance\BusinessPlan.txt

Open the share \\DC1\data
Open the Finance folder

el
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5. Right-Click the Historical.txt and choose Properties

6. Click the Previous versions tab

7. Select the previous version of the Historical.txt file

8. Click Copy and Direct it to the Desktop

9. Open the Historical.txt file on the desktop and see the original version of the file
10. Access the Previous versions of the Finance Folder

11. Right-Click the BusinessPlan.txt and choose Copy

12. Open the Finance Folder in the \\DC1\data folder

13. Paste the BusinessPlan.txt file into the folder
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Module 3 — Installing and Configuring a Printer

Requirements

A Computer installed with Windows Server 2003 in the finalvision.com domain named DC1.

Exercise 1. Add a Local Printer and Configure Print Sharing

1. Logon as Administrator

2. Open Printers and Faxes folder

3. Double-Click Add Printer, Printer Wizard will appear

4. Click Next, The Local or Network Printer Page will appear

5. Verify Local Printer option is selected and Automatically Detect and Install My Plug And Play Printer is
unchecked and Click Next

6. The Printer Port Page appears, Click Create a New Port

7. Select TCP/IP Port

8. Click Next, The Add Standard TCP/IP Printer Port Wizard appears

9. Click Next

10. Enter IP Address: 10.10.0.51 and except the default port name IP_10.0.0.51

11. Click Next

12. Select Hewlet Packard Jet Direct as the device type

13. Click Next and Finish

14. From Manufacturer list select HP and from the Printers select HP Laserjet 4 and Click Next
15. Type HPLJ4 and Click Next

16. Verify that the Share Name is option selected

17. In Share Name text box type HPLJ4 and click Next

18. In location type USA/FL/1805Butler/42/B

19. Comment box type Black and White Output Laser Printer High Volume
20. Click Next

21. Choose No

22. Confirm Summary

Exercise 2: Connect a Client to Printer

Open Printer and Faxes Folder

Start Add Printer Wizard

Click Next

In Local or Network Printer dialog box select a Network Printer and click Next
In the Location box type FL and click Find Now

Select the HPLJ4 and click OK

On the Add Printer Wizards Default Printer Page select Yes and Click Next
Click Finish
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Exercise 3: Take a Printer Offline and Print a Test Document

Right-Click the HPLJ4 in the Printer and Fax Window

Choose Use Printer Offline

Double-Click the HPLJ4 icon

Open Notepad and type some information

Arrange windows so that you can see the printer and notepad

From the File menu of Notepad Select Print — Document stays in Queue because printer is offline
Click Print

Close Notepad and Click No

. Select the document in the HPLJ4 and From the Printer Menu select Cancel All Documents Confirm
10. The document is removed

11. Close all windows
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Module 4 — Advanced Printer Configuration and Management

Requirements

A Computer installed with Windows Server 2003 in the finalvision.com domain named DC1.

Exercise 1. Add a Local Printer and Configure Print Sharing

1. Create a new printer with , Configure HP LaserJet 4 with IP address of 10.0.0.52 a new port call it PrintPool
use location type USA/FL/1805Butler/42/B

location type USA/FL/1805Butler/42/B

Open the properties of PrintPool

Click Port tab

Select Enable Printer Pooling check box

Click check box next to the port IP_10.0.0.51

Click Apply

Noukwn

Exercise 2: Add a Local Printer and Configure Print Sharing

1. Create a new printer with , Configure HP LaserlJet 4 with IP address of 10.0.0.52 a existing port call it
PriorityPrinter use location type USA/FL/1805Butler/42/B

2. Open the properties of PriorityPrinter

Click the Advanced Tab

4. Set Priority to 99 (highest)

w

Exercise 3: Examine Active Directory Printer Objects

Open Active Directory Users and Computers

From the View Menu select Users, Groups, and Computers as Containers

Expand the Domain Controllers OU

Select DC1

Open the properties of the PriorityPrinter object — view the properties and notice they are less than in
Printers and Faxes — used for searching in Active Directory

kN e
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Module 6 — Troubleshooting a Printer

Requirements

A Computer installed with Windows Server 2003 in the finalvision.com domain named DC1.

Exercise 1: Redirect a Printer

Ensure that the HPLJ4 is offline under Printers and Faxes
Open Notepad and enter text

Choose Print from the menu

Double-Click HPLJ4 to view the Queue

From the Printers menu, choose Properties

Click Ports tab

Select check box next to IP_10.0.0.52

Click OK —The printer is now redirected
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Module 9— Maintaining the OS

Requirements

A Computer installed with Windows Server 2003 in the finalvision.com domain named DC1.

Exercise 1: Download and Extract the Service Pack

Create a folder on the C Drive and name it ServicePack

Download a service pack from Microsoft download site

Open a Command Prompt and change into the ServicePack directory
Type Servicepack Name — x to redirect to another directory

Indicate that you want to extract into the ServicePack directory

ukhwnNeE

Exercise 2: Deploy the Service Pack with Group Policy

1. Share the ServicePack directory with Share name of ServicePack

2. Open Active Directory Users and Computers

3. Expand the domain and locate (or create) the Desktops OU

4. Create a computer object in the Desktop OU called Desktop01

5. Create a GPO called SP-Deploy

6. Open GPMC

7. Right-Click the Desktop OU and choose Create And Link A GPO Here
8. Name the GPO SP-Deploy

9. Right-Click the SP-Deploy and click edit

10. Navigate to Computer Configuration\Software Settings

11. Right-Click Software Installation and select New and then choose Package
12. Type the path \\dcl.finalvision.com\servicepack and press enter

13. Navigate to the Update.msi file you identified in the previous exercise
14. Click Open

15. Select Assigned and OK

16. Close Group Policy Object Editor

Exercise 3: Configure Automatic Updates

1. Create a GPO called WSUS-Config

2. Openthe GPMC

3. Right-Click the finalvision.com domain

4. Create And Link A GPO Here

5. Name GPO WSUS-Config

6. Editthe Policy

7. Open Windows Update by Computer Configuration/Administrative Templates/Windows Components
8. Double-Click the policy: Configure Automatic Updates and then select Enabled

9. Configure Automatic Updating drop-down list choose 4-Auto Download and Schedule to Install
10. Confirm Installation Schedule: Daily at 3:00AM

11. Click OK

12. Double-Click Reschedule Automatic Updates Scheduled Installation and then select Enabled
13. In the Wait After System Startup Minutes type 10 and Click OK

14. Close the Group Policy Object Editor

15. Restart Server — Examine the Automatic Updates tab in Control Panel to view the settings
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Module 10— Recovering from System Failure

Requirements

A Computer installed with Windows Server 2003 in the finalvision.com domain named DC1.
Second Physical Disk to perform ASR

Exercise 1. Backup the System State

Logon to DC1 as Administrator

Open the Backup Utility

If the Backup and Restore Wizard appears , click Advanced Mode
Click Backup Tab

Select System State checkbox

Type a file name : c:\SystemState.bkf

Start the backup

NouswhpeE

Exercise 2: Create an ASR Set

This exercise requires a floppy disk and approximately 1.5GB of free space. To complete
exercise 4 you must complete this exercise.

1. Open Backup utility
2. Click Automated System Recovery
3. Follow the prompts, backup to a file ASRBackup.bkf on C or on the second drive

Exercise 3: Installing and Using Recovery Console

1. Insert the Windows Server 2003 CD-Rom

Click Start, run and type: D:\i386\winnt32.exe /cmdcons

Open Services console from Administrative Tools , Locate Messenger service, Double-Click the service and
choose Automatic as Startup type

Restart the Server

Select Windows Recovery Console from the Boot Menu

When prompted type 1 too select the installation of Windows Server 2003
Type the password for the local Administrator

When the Recovery Console appears type help

. Type listsvc to list the services

10. Type disable messenger to disable the service

11. Type exit and Press ENTER
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Exercise 4: Restoring a System Using Automated System Recovery

Power Off Computer

Restart the computer start with Windows Server 2003 CD-Rom

Press a key to start from the CD

Press F2 during text mode setup phase

Insert the ASR floppy disk

Text-mode setup prepares for Automated System Recovery and a minimal version of the operating system

is loaded

Windows Server 2003 setup screen will appear after some time

8. Windows Server 2003 partitions and format the disk, copies files, initializes the Windows configuration
and then prepares to restart

9. Remove the floppy from the disk drive and allow the computer restart

e Installation will continue and return the computer to the previous state
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